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This file lists all changes made to ETABS since the previous version. Most changes do not affect most users. 

Incidents marked with an asterisk (*) in the first column of the tables below are deemed more significant. 

 

Changes from v13.1.5 (2014-06-13) 

User Interface 
Enhancements Implemented 

* Incident Description 

 13758 Load combination names are now sorted in numerical order for names beginning with alphabetic 

characters, whereas previously they were sorted in Windows default alpha-numerical order. For 

example, names previously ordered as DCon1, DCon10, DCon11, DCon2, DCon3, ..., DCon9 are 

now ordered DCon1, DCon2, DCon3, ..., DCon9, DCon10, DCon11. This affects the commands 

Define > Load Combinations and the various Design > > Select Design Combinations. 

 56187 An enhancement has been implemented to indicate the license level and version number in the title 

bar of the graphical user interface main window. 

 60243 An enhancement has been implemented to set the initial focus of the Frame Assignment - Section 

Property form to the Filter field, allowing the user to immediately start typing the name of a section 

to filter the list. 

 62127 An enhancement has been implemented on the Link Assignment Property form to now display the 

properties in sorted order. 

 63307 An enhancement has been implemented to order joints alphabetically in the form used for the 

command Display > Response-Spectrum Curves. 

 65481 An enhancement has been made to show the frame sections in the design overwrites form in the 

same special sort order as used in the frame sections definition form. 

 67106 An enhancement has been implemented to provide user control over the amount of zoom that occurs 

when using the mouse wheel by linking it to the Auto Zoom Step option in the graphics preferences 

(command Options > Graphics Preferences). 

 67515 An enhancement has been implemented in the Set Elevation View form to set the initial focus to the 

filter box. 

 68440 

69166 

An enhancement has been implemented to now show wall edge colors in plan view based on the 

requested color specification (material, section, group, etc.). 

 68799 An enhancement has been implemented to provide more detailed messages when the model file 

(.EDB) is unable to be saved because of disk-full or other conditions. 

Modeling 
Enhancements Implemented 

* Incident Description 

* 53793 The Auto-Relabel All option that was available in ETABS v9 has been restored. 

 65234 An enhancement has been implemented to add the Russian material property and section property 

libraries. 

 66704 An enhancement has been implemented to add undo and redo options for Group definitions and 

Group assignments to objects. 
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* Incident Description 

* 67569 A number of enhancements have been implemented to incorporate ASCE 41-13 guidelines for 

performance-based design. (1) Frame hinge definitions have been updated to follow ASCE 41-13 

guidelines. Older files with automated FEMA hinges will be converted to follow the new 

guidelines. (2) The performance point calculations for pushover curves have been updated to ASCE 

41-13. (3) To clarify their different performance-based acceptance criteria, masonry material has 

been added as a separate material; previously it was treated as a subset of the concrete material. (4) 

Panel-zone and BRB (buckling-restrained brace) definitions have been updated to accommodate 

ASCE 41-13 behavior and acceptance criteria. (5) Other minor enhancements have been made to 

improve the plotting and reporting for performance-based design. 

* 68038 An enhancement has been made to allow multiple named mass-source definitions in the same 

model. Different load cases of type nonlinear static or nonlinear dynamic can then use different 

mass configurations. Linear cases starting from these nonlinear cases will use the corresponding 

mass configuration. One of the mass source definitions is declared as the default and that is used for 

all load cases not starting from a nonlinear case, as well as for the auto P-Delta case based on mass, 

and for all auto seismic load patterns used to calculate loads. 

 68089 The Check Model feature has been enhanced to allow automatic correction of connectivity issues 

(gaps and overlaps) within a user-specified tolerance for members that are selected prior to using 

the command Analyze > Check Model. 

Section Designer 
Enhancements Implemented 

* Incident Description 

 59988 An enhancement has been implemented in the Section Designer such that it now defaults to using 

the base material when drawing shapes of the base material type (i.e. steel, concrete, etc). 

Previously it was choosing the first material matching the type of shape that was being drawn. 

Loading 
Enhancements Implemented 

* Incident Description 

 52704 The Singapore National Annex has been added as an option to the Eurocode 8-2004 response 

spectrum function. 

 61659 An enhancement has been made to allow notional load patterns to now be based on snow loads as 

well as other gravity loads. 

* 69133 An enhancement has been made to rectify the difference between the self-weight of frame members 

as accounted for in the analysis and the material weights given in the tables. The difference was due 

to the material tables accounting for the duplication of material at the beam column joints by 

ignoring the beam weight overlapping the column while the analysis was not ignoring the overlap. 

A user control is now provided on the End-Length Offset form to explicitly specify if the weight of 

the offset portion is to be excluded. Both the analysis and the material tables will now be consistent 

in this respect. Note that the two can still differ if weight modifiers are specified on the frame 

section or assigned to the frame object, as these affect only the analysis and not the material tables. 

Analysis 
Enhancements Implemented 

* Incident Description 

 65587 Nonlinear static analysis, including staged construction, has been enhanced to allow the use of the 

line-search algorithm during iteration. This feature was already available for nonlinear direct-

integration time-history analysis. Line search is helpful for models where the stiffness changes 

significantly from one step to the next, particularly in cases where the model is stiffening. The line-

search option is only available under force control and when event-to-event stepping is not used. By 

default line-search is turned off, since event-to-event stepping is more effective for most case. 
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* Incident Description 

* 65841 

66696 

The speed of analysis has been increased by internal changes that have no effect upon results. 

* 67283 The iteration strategy for nonlinear static and nonlinear direct-integration time-history load cases 

has been made more adaptive to typically improve convergence behavior and to reduce the time of 

analysis. User-specified limits on the number of constant-stiffness and Newton-Raphson iterations 

are used to guide the iteration, but may not be strictly observed. Models run in the new version 

should produce the same results as in the previous version, subject to minor variations 

approximately within the convergence tolerance. Larger differences may be observed for ill-

conditioned or sensitive models. Analysis Verification Example 14 has been updated for minor 

changes in results due to this enhancement. 

Frame Design 
Enhancements Implemented 

* Incident Description 

 55074 An enhancement has been made to the steel frame design for the Indian IS 800:2007 code to 

implement the changes in Amendment Number 1. 

 60171 Steel frame design has been enhanced for the display of the design input parameters (overwrites) 

using the command Design > Steel Frame Design > Display Design Info > Design Input. Numerical 

values of the input parameter being displayed will be shown with an asterisk (*) if they are 

program-determined (automatic) and will be shown without an asterisk if they were assigned by the 

user using the command Design > Steel Frame Design > View/Revise Overwrites. Program-

determined numerical values will only actually be displayed for a member after it has been 

designed, while user-defined values will be shown before or after design. For the following codes, 

additional overwrite items are now available for display: AS 4100-1998, EC 3-2005, Italian NTC 

2008, IS 800:2007, and NZS 3404:1997. 

 62714 An enhancement was made for concrete frame design, steel frame design, and shear wall design per 

the Canadian design codes (i.e., CSA A23.3-04 and CSA S16-09) to now include snow loads in the 

default design combinations. 

 62719 

68721 

An enhancement was made for concrete frame design per the AS 3600-09 code where Nuo 

(i.e., ultimate strength in compression, without bending, of an axially loaded cross-section) will no 

longer be subject to the 0.75 capacity limit given in Section 10.3.3. Section 10.3.3 is only applicable 

for short braced columns with small bending moments where the bending moment is to be ignored 

for design. This situation is not applicable in ETABS frame design since moments are not ignored. 

 67315 Concrete frame design has been enhanced to additionally report the total transverse rebar required 

(shear plus torsion) in the right-click design details and for the plot in the model window. This 

affects the following codes: ACI 318-11, ACI 318-08, AS 3600-09, TS 500-2000, Eurocode 2-2004, 

and Italian NTC 2008. 

Composite Beam Design 
Enhancements Implemented 

* Incident Description 

 59912 An enhancement was made to the design of composite beams per the AISC 360-05 and 360-10 

codes. The Composite Design Preferences form now allows the user to specify the relative position 

within the deck rib of shear studs welded to a beam through a deck with its ribs perpendicular to the 

beam. The default relative position is the Middle of the ribs, with Strong Position and Weak 

Position also available. Examples AISC-360-05 Example 001 and AISC-360-10 Example 001in the 

Composite Beam Design Verification Manual have been updated accordingly. 

* 65379 

65479 

Several enhancements have been made to the design of composite beams: (1) The Composite Beam 

Design Preferences form now features two additional tabs for Shear Stud preferences and Camber 

preferences and several new preference items, including: (a) project-wide minimum and maximum 

percentages of composite action (b) project-wide minimum and maximum shear-stud spacing (c) in 

the case of design per the AISC Specification, the location of the shear studs within the deck ribs 
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* Incident Description 

(strong or weak position) (d) a minimum beam span, beam depth and section web thickness for 

cambering beams (e) a unit price for steel. After changing design preferences, any individual beam 

overwrites are now retained (previously they were being reset to default). In addition, all beam 

designs are retained and can be checked against the new preferences with the Verify All Members 

Passed command. (2) The Composite Beam Design Overwrites form now features an option to limit 

the width of the selected steel section. (3) The Interactive Composite Beam Design and Review 

form has a new look and functionality. Summary design check results for any potential design are 

now shown on the form itself (the Details sub-form is still available). For any potential design, the 

user can adjust the percentage of composite action, the camber and, in the case of a girder 

supporting beams, whether shear studs are specified as a total number or as a breakdown across 

segments. (4) Changes made in the Interactive Composite Beam Design and Review form will be 

applied to the member when clicking the OK button. The corresponding beam will be affected in 

other stories if the Similar stories or All stories option is active in the main window of the graphical 

user interface. (5) Beam designs are retained when the model is reanalyzed and can be checked 

against the latest analysis results with the Verify All Members Passed command (6) The output for 

individual beams has been rearranged to fit on one page for most beams and girders, and at the same 

time, includes new information such as (a) the loading of the beam (b) a breakdown of the 

horizontal shear force transmitted by the shear studs (c) the Y1 and Y2 distances listed in Table 3-

19 Composite W-Shapes of the AISC Steel Construction Manual for convenient cross-reference. (7) 

Two new commands, Copy Design and Paste Design let the user apply a selected design from one 

beam to others. 

 71279 An enhancement has been made affecting the design of composite beams per any design code. 

When the user specified a stress-ratio limit other than unity, this stress ratio limit was being applied 

to deflection and vibration checks as well. When this occurred, the designs were conservative and 

the strength of the beams was not affected. ETABS now applies the stress-ratio limit to strength 

checks only, and passes the deflection and vibration checks if the design values are less than the 

allowable values. 

Shear Wall Design 
Enhancements Implemented 

* Incident Description 

 36598 

38550 

42417 

Shear wall design per the Indian IS 456:2000 code has been enhanced to add control in the Wall 

Design Preferences for enforcing the minimum eccentricity due to slenderness separately in the 

major and minor directions. 

 63048 An enhancement was made to shear wall design for the Eurocode 2-2004 code to expose the Force 

Modification Factor for Shear Design in the design preferences. Previously the built-in default value 

was and still is 2.0, but now users can explicitly overwrite the default value in the shear wall design 

preferences. 

 68006 An enhancement has been made to add descriptive notes to items in the shear-wall design 

preferences form for all design codes. This does not affect any design results. 

Results Display and Output 
Enhancements Implemented 

* Incident Description 

 55089 An enhancement has been implemented to allow sorting tabular data by story, object, or load when 

the tables contain any of these columns. This can be set in the table options for displaying and 

exporting tables, as well as the report settings for generating reports. 

 63998 An enhancement has been implemented to show the wind loads applied to stories in the report when 

the loads are based on exposure from area objects. 

 68830 An enhancement has been implemented to improve the line quality when export to PDF is used. The 

line thickness is no longer dependent on the model window size and zoom level. 

 71881 An enhancement has been implemented to restrict the calculation of story drifts reported in the joint, 
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* Incident Description 

diaphragm and story drift tables to only those joints that have a column, brace or wall support 

underneath. This change produces meaningful results with less data. 

Database Tables 
Enhancements Implemented 

* Incident Description 

 57625 An enhancement was implemented to add database tables for section cut definitions. 

 60816 An enhancement was made in the Shear Wall Pier Summary tabular output to report the shear 

reinforcing and boundary-zone information for each leg when multiple legs are present in a pier. 

 68532 An enhancement has been made to provide additional information on hinge status in tables created 

from static pushover plots of base shear vs. displacement. 

 69061 An enhancement was implemented adding the following new database tables that display additional 

information for certain load cases. (1) Load Cases - Response Spectrum Eccentricity Override  (2) 

Load Cases - Proportional Damping  (3) Load Cases - Interpolated Damping  (4) Load Cases - 

Damping Overrides. 

 70425 An enhancement was implemented to add object unique names to the analysis results database 

tables where applicable. 

Data Files (.EDB, .E2K, .$ET) 
Enhancements Implemented 

* Incident Description 

 67004 An enhancement has been implemented to include table set definitions in the text file (*.e2k, *.$et) 

for export and import. 

External Import/Export 
Enhancements Implemented 

* Incident Description 

 64916 

69417 

An incident related to the import of Revit Structure projects was resolved. When a Revit column 

spanning multiple stories and not aligned with the X or Y axis was imported in ETABS, its 

orientation in ETABS was the opposite of its original orientation in Revit. When this occurred, the 

results agreed with the model as imported.  

In addition, several enhancements have been made to the import of Revit Structure projects and 

export of ETABS models to Revit Structure. These enhancements require Revit Structure 2015 and 

CSiXRevit 2015. (1) The import of precast concrete structures has been enhanced as follows: (a) 

Revit precast concrete sections are now identified (b) Revit precast-concrete double-tee framing 

elements are now imported as pairs of single tee beams in ETABS (c) Revit precast-concrete solid-

slab framing elements are imported as ETABS floor area objects. (2) The original family name of 

Revit elements is stored in ETABS and exported back to Revit if it is compatible with the section 

shape of the corresponding line objects in ETABS. (3) ETABS removes extraneous blank spaces 

from Revit British Universal Beam and Column designations, and if it does not find a matching UC 

or UB section, ETABS looks for an equivalent UKC or UKB section. 

Documentation 
Enhancements Implemented 

* Incident Description 

 59189 The Lateral Loads Manual has been updated to explain the Seismic (Drift) load pattern type in 

Chapter 2, Section 2.2. 

 66166 The context sensitive help now contains a list of the default keyboard shortcuts. These shortcuts can 

be modified using the Options > Customize Toolbars command, in which case the default shortcuts 

may no longer apply. 
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* Incident Description 

 71127 The composite beam design verification examples manual and associated ETABS models have been 

updated. A few hand calculations were inaccurate and as a result did not exactly match the ETABS 

output. These calculations were corrected and now more closely match the original numbers output 

by ETABS. Other manual revisions are due to the ETABS output changing as a result of 

enhancements being made and incidents getting resolved; these changes appear in the Release Notes 

relative to these other enhancements and incidents. 

Miscellaneous 

* Incident Description 

 60063 The version number has been changed to v13.2.0 for a new minor release.  

 

 

 

 

User Interface 
Incidents Resolved 

* Incident Description 

 62746 An incident was resolved where an Elevation view could not be renamed when added at specific 

ordinates using the command View > Set Elevation > Add at Ordinate. Now a ‘Change Name’ 

option is provided to rename such added Elevation views. Note that elevations from the grid 

systems can be renamed in the grid system definition. 

 64330 An incident was resolved where the command Display > Load Assigns > Shell would not properly 

display the form used to select the load case to be shown in certain rare cases when temperature 

loads were present on shell objects. 

 65747 An incident was resolved where deleting a pier/spandrel label during the assign pier/spandrel 

process after the model was run and then saving the model would cause a runtime error and the file 

would not be saved. 

 65919 

67790 

An incident was resolved where wind parapet information in the auto wind load form for ASCE 7-

05/7-10 codes did not display correctly when the form was reopened and thus appeared to have not 

been saved. The values shown when the OK button were last clicked were used for analysis, 

regardless of what the form showed. 

 67694 An incident was resolved where, in some rare cases, a developed elevation view was not saved 

when the model was saved and reopened. The view reverted to a default 3D view. No results were 

affected. 

 68339 

69633 

An incident was resolved where, in some rare cases, the Select by Spandrel Labels form could not 

be opened when using the command Select > Select > Labels > Spandrel Labels. No results were 

affected. 

 68434 An incident was resolved where opening an item for modification from the Model Explorer tree 

would sometimes bring up the form for the wrong item. This could happen when the selected item 

had a name that was a subset of the name of another item in the list. When this happened, it was 

obvious which item was being modified and results agreed with the model. 

 69111 An incident was resolved where the frame section assignment form (command Assign > Frame > 

Section Property) could behave incorrectly: using the Apply button multiple times could cause the 

list of frame sections to become unusable, and/or the form could close itself. This did not affect the 

model or any results. 

 69637 An incident was resolved where coordinates displayed at the bottom-right corner of the graphical 

user interface were incorrect when using architectural units (feet, inches and fractional inches) and 

the coordinate value was negative. The value could be in error by one foot due to rounding. This 

was a display issue only. 
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* Incident Description 

 69942 An incident was resolved where the thickness of layered shell walls was not shown with the correct 

thickness in extruded views. This was a display issue only. 

 70353 An incident was resolved where planar walls with multiple wall thicknesses were not displayed 

correctly in plan views. This did not affect any results. 

 70459 An incident was resolved where the rebar area units on the frame section property reinforcement 

form were using Area (Length^2) units instead of Rebar Area units. This could affect the accuracy 

of the values (i.e., the number of digits) displayed when the form was re-opened and the OK button 

clicked, otherwise results were unaffected.  

 71479 An incident was resolved where the position of the centroid for some Section Designer sections was 

not shown correctly in the display (plan view and extruded 3D view). This was a display issue only 

and no results were affected.  

 71721 An incident was resolved where the value of Rigid Frequency, f2, for a response-spectrum load case 

was not retained when setting it using the command Define > Load Cases. It was always defaulting 

to zero, which had the effect of not considering rigid frequency behavior. 

 71865 An incident was resolved where selecting piers by labels may, in some rare cases, select the wrong 

pier. 

 71974 An incident was resolved where in some cases a new story could not be added to the model when 

link objects were present in the model. 

Graphics and Drafting 
Incidents Resolved 

* Incident Description 

 60891 An incident was resolved where the quick draw commands were not working when using the 

Chinese language option. 

 60927 

61848 

An incident was resolved for the command Draw > Draw Grid where grids were drawn twice the 

specified Plan Offsets Normal distance. 

 64359 An incident was resolved where in some cases the reshape tool would not work in certain elevation 

views. 

 69369 An incident was resolved where display of extruded shells was not correct when ribbed slabs were 

present. 

 70613 An incident was resolved where the extruded shape shown in the model window for certain Section 

Designer sections could appear incorrect for models opened from older versions of the software. No 

results were affected. Now such sections are corrected when the model is opened so that they appear 

correct when displayed as extruded. In older versions of ETABS, opening the affected sections in 

Section Designer and clicking OK back to the main window would also correct the displayed shape. 

Modeling 
Incidents Resolved 

* Incident Description 

 66923 An incident was resolved where pasting joint-coordinate information from Excel (command Edit > 

Paste) did not add the joints to the model. 

 68376 An incident was resolved where replication of links would sometimes cause the replicated links to 

lose the link property assignment. In such a case the link property would be identified as "None". 

Analysis and design results agreed with the model when this occurred. 

 68883 An incident was resolved where nonlinear auto concrete beam hinges could not be assigned to 

frame objects with concrete T and L sections. Now auto hinges can be assigned to frame objects 

having these types of sections using the ASCE 41-13 Table 10-7 (Concrete Beams) hinge 

assignment options. Other types of auto hinges are not supported for these sections. 

 68933 An incident was resolved where the correct frame section property was not assigned to replicated 

frame objects when the Replicate command was used and the ‘Similar Stories’ or ‘All Stories’ 

option was on. This happened when there was a conflict between the replicate and similar stories 

options. Now the replicate takes precedence over the similar stories option. 
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* Incident Description 

 70143 An incident was resolved where the torsional constant calculated for certain flanged sections (T, L, 

C) could have been incorrect, even negative, if the thickness of a flange was larger than its width. 

 70156 An incident was resolved where the torsional constant J calculated for concrete-filled pipe sections 

was obviously too large. This did not affect similar sections created using the Section Designer nor 

were other section shapes affected.   

Section Designer 
Incidents Resolved 

* Incident Description 

 68735 An incident was resolved where, in some rare cases, the shear area and torsion for some Section 

Designer sections would be incorrectly calculated as zero. When this occurred the error was obvious 

by reviewing the calculated properties, and results agreed with the calculated properties. 

Loading 
Incidents Resolved 

* Incident Description 

 64093 An incident was resolved for the ASCE 7-10 auto wind load pattern where the form was still 

showing the Importance Factor ‘I’. The importance factor is no longer available when the ASCE 7-

10 auto wind load pattern is selected. The loading was not affected as the importance factor was not 

used for ASCE 7-10 code calculations. The Lateral Loads Manual has been updated to reflect the 

correct sections from the ASCE 7-10 code. 

 65431 An incident was resolved for auto lateral wind load where the Wind Direction angle was not saved 

correctly. 

 67298 

67461 

An incident was resolved in which the zip-code, latitude-longitude, and/or island location 

information was not available when defining ASCE 7-05, ASCE 7-10, and NTC-08 response-

spectrum functions or auto-seismic load patterns when ETABS was run from the default shortcuts 

created during installation. When this occurred an error message was generated. Running ETABS 

by double-clicking on the application or with user-created shortcuts would enable the location data 

to be accessed as expected. 

 68594 An incident was resolved where, in some rare cases, line loads on Null lines (frames) were not 

being transferred to the area (shell) objects underneath them. This was a tolerance-related issue that 

could have occurred when the line was very close to the edge of the area. 

 68745 An incident was resolved for auto seismic load based on the NBCC 2010 code where the minimum 

base shear for a shear-wall system was not enforced correctly. The minimum base shear was using 

S(2.0) instead of using S(4.0) which produces higher minimum base shear. Results were always 

conservative. 

* 70505 An incident was resolved where the auto static seismic loads were being duplicated for multiple 

tower models. Automated loading for multiple tower models is not recommended as it is based on a 

single dominant period. 

Analysis 
Incidents Resolved 

* Incident Description 

 54802 An incident was resolved where the Reduced Beam Section (RBS) specification was not being 

applied when assigned to a frame section imported from a database. It did work correctly when 

assigned to frame sections explicitly defined by the user. 

 60964 An incident was resolved where the analysis could sometimes be terminated prematurely and the 

analysis results lost if previous analysis results were present and were being displayed in the 

graphical user interface (GUI) before an analysis was started, and then the GUI was minimized and 

maximized or otherwise resized while the analysis was running. Only models running the analysis 

as a separate process (either set explicitly by the user or determined automatically by the program) 
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* Incident Description 

were affected. When this occurred, the model would be unlocked so that it was obvious that the 

results were lost. In some cases an error message was generated. Analysis results, if not lost, were 

correct and not affected by this error.  

 62419 An incident was resolved where, in some rare cases, an ETABS v9 model opened in v13 would give 

a run-time error when the analysis was run. This only affected models where the concrete design 

code was Chinese and an artificially low or zero value was input for concrete material strength in 

the v9 model. 

 66562 An incident was resolved where the shear area of double angles and double channels in the minor 

direction kept increasing with increasing distance between the component sections. It is now 

restricted to not exceed the area of the section. 

 66916 An incident was resolved where the analysis was unable to run for certain large models using the 

64-bit version when available RAM (memory) was small. The use of limited RAM has been made 

much more efficient, however it is still possible that very large models may not run unless adequate 

RAM is available. 

 68075 An incident was resolved where an error message was issued during analysis if seismic loads of 

type User had no loads defined. 

 70221 An incident was resolved where the forces and moments from section cuts that contained shells 

(walls), including story shears, could be incorrect for nonlinear static and direct-integration time-

history load cases that include P-delta, as well as for linear load cases that use the stiffness from the 

end of such nonlinear load cases. Reactions at restrained joints connected to shells (walls) were 

similarly incorrect. The forces and moments were being calculated using the displacements that 

included the P-delta effect, but with the original material stiffness without any correction for P-delta 

effect. For the common case of P-delta compression, this tended to overestimate the reported 

results. In the case of tension stiffening, the reported forces and moments could be underestimated. 

This error was generally small in practical structures, although it tended to be more pronounced in 

tall buildings. Only the contribution from shell objects was affected, not from frame or link objects. 

* 70951 An incident was resolved where the convergence behavior of the triple-pendulum isolator (link 

property) was poor for circumferential behavior. This could cause time-history load cases with 

independent loading in two directions to run slowly or to not converge, in which case results were 

not available. Radial behavior (along a fixed shear direction in the U2-U3 plane of the isolator) was 

not strongly affected. The overall convergence behavior of the triple-pendulum isolator has been 

made more efficient, and some small difference in results may be expected even for radial behavior. 

* 71243 An incident was resolved where the slab local axis specification was not being applied to the 

analysis mesh if the slab meshing method was the default. It only affected analysis results if 

orthotropic slab properties were either specified directly or created through bending modifiers. Shell 

stresses were also being reported in this case based on the default local axes (local axis angle = 0). 

 71364 An incident was resolved where, under certain rare conditions due to tolerance issues, some meshed 

floor shell elements for the analysis model were deleted and behaved as openings. When this 

occurred the error was obvious by looking at the deformed shape or shell stresses. 

Frame Design 
Incidents Resolved 

* Incident Description 

 46770 An incident was resolved for the steel frame design of columns in eccentrically-braced frames 

(EBF) where the axial force calculated due to the capacities of EBF link beam capacities was not 

correct when the columns were shared by multiple EBF bays. The axial force for columns 

connected to more than one EBF bay was based on the summation of the shear capacities of all the 

link beams above the story level of the column that was connected to the bays. This was too 

conservative. Now the axial force for columns shared by more than one EBF bay is calculated 

based on the summation of the maximum shear capacities of link beams that are connected to the 

bays and that are above the story of the affected column. Only one capacity, the maximum from all 

the link beams connected to the bay, is taken per story in the summation. Affected codes are AISC 

360-05, AISC 360-10, and CSA S16-09. 
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* Incident Description 

 53761 An incident was resolved for steel frame design using the AISC 360-05 and AISC 360-10 codes 

where changing the Design Provision to ASD in the design preferences did not correctly update 

the strength reduction factors in the design preferences form. When the ASD option was selected, 

the design preferences form was still showing the default values for the LRFD option. 

 53902 An incident was resolved where the command Design > Lateral Bracing could not be used to reset 

the lateral bracing back to ‘Program Determined’ (no lateral bracing) once user-defined bracing 

had been specified for a given member. The values of effective length actually being used for 

minor bending and lateral torsional buckling were being correctly reported and the design results 

produced were consistent with these values. 

 59145 An incident has been resolved in concrete frame design for all concrete frame design codes in 

which the shear areas of the concrete for certain sections were not being calculated correctly. The 

affected sections were L-shapes, T-shapes, Boxes, Pipes, and Cross-shapes. When this error 

occurred the effect was generally small. The shear areas for Rectangles, Circles, and Section 

Designer sections were not affected. 

 55179 An incident was resolved for steel frame design using the AISC 360-10 code in which the value of 

Ry was not being taken correctly and was not being reported correctly. The value of Ry is now 

taken as the ratio of fy (expected) over fy (design). These values can be input by the user while 

defining the steel material property. 

 59295 An incident was resolved for composite column design per the AISC 360-10 code where the 

coefficient B1 factor was not being computed when the Amplified 1st Order method was selected 

in the design preferences. Instead the value of B1 was always taken as unity (1.0) for this case.  

 60072 

65308 

An incident was resolved for steel joist design where some members were unable to be designed 

and instead displayed the error message “This joist is not designed because there is negative 

moment" or similar. This issue generally occurred when design moment was less than the internal 

tolerance used in the default database units. 

 60484 An incident was resolved for composite column design per the AISC 360-10 code where the 

section capacity for minor axis bending was sometimes computed as zero. This could happen 

when selected steel sections were large, and would cause the D/C ratio to be reported as infinity.  

* 61883 An incident was resolved for seismic design of concrete beam-column joints where the joints were 

always assumed to be confined in both the major and minor directions instead of getting the 

confinement from connecting beams. All concrete frame seismic design codes were 

affected. Models with concrete frame seismic designs should be re-run using the new version, 

since the previous results could be unconservative. This issue affected v13.0.0 to v13.1.5. 

 64074 An incident was resolved for steel joist design that addressed the following issues:  

(1) Superimposed dead loads and roof live loads were not automatically being included in the 

default load combinations created for steel joist design. (2) The deflection check as reported had 

an incorrect conversion factor and label for the units; force units were being used rather than 

length units. 

 64491 An incident was resolved for steel frame design where columns located below the Base level were 

not being designed when using the command Design > Steel Frame Design > Start Design/Check. 

However, the design was being performed when right-clicking on such a member while displaying 

design results. No other results were affected.  

 65751 An incident was resolved for composite column design where the parameters Analysis Method, 

Second Order Method, and Stiffness Reduction Method were not saved in the design preferences. 

In addition, the design report for the concrete-filled pipe/tube was showing some parameters which 

were not being used in the design. These parameters are no longer reported. 

 65937 An incident was resolved for composite column design where the moment capacity of concrete-

filled pipes was incorrectly computed. The capacity was being underestimated and the error was 

always conservative. In addition, a typographical error in the AISC 360-10 Composite Column 

Design manual has been corrected for the equation on page 3-31 to calculate the theta angle for a 

circular composite section. This was a documentation error only and no results were affected.  

 67203 An incident was resolved for composite column design per the AISC 360-10 code where 

repeatedly right-clicking on a member while displaying design results would keep changing the 

Demand/Capacity (D/C) ratio shown. The D/C ratio when design was first completed was correct. 



ETABS 2013 v13.2.0 2014-11-03 Page 11 

* Incident Description 

 67908 An incident was resolved for steel frame design using the codes AS 4100-1998 and NZS 3404-

1997 in which the interaction equation and the value of Noz was not being reported. This was a 

display issue only. No results were affected. 

 68139 An incident was resolved for steel joist design where the reported controlling load combination 

may have been incorrect. This was only a reporting issue and design results were not affected. 

 68908 An incident was resolved for concrete frame design where the optimization algorithm for auto 

concrete sections used, when used for concrete columns, was restricting the design rebar to a 

maximum of one percent and was thus resulting in larger sections than needed being selected or a 

failure condition being declared. When this occurred, the results were over-conservative. 

 69079 An incident was resolved for steel frame design where compression-only members were 

sometimes incorrectly reported as flexo-compression members. Although the reported section 

classification could have been incorrect, there was no effect on the PMM ratio, which was correct. 

Affected design codes included AISC 360-05, AISC 360-10, AISC-LRFD 1993, AS 4100-1998, 

China 2010, CSA S16-05, CSA S16-09, Eurocode 3-2005, IS 800:2007, Italian NTC 2008, and 

NZS 3404-1997. 

 69757 An incident was resolved for steel and concrete frame design where the load type Roof Live was 

not being added to the gravity portion of the design forces. It was included in the total design 

forces. This error did not affect other types of live loads. This could slightly affect the design for 

design codes where special treatment is given to gravity forces. 

 71477 An incident was resolved for steel frame design using the Eurocode 3-2005 and NTC 2008 codes 

in which sections with 3mm thick elements were being reported as being too slender to design, 

while the design code permits 3mm thick elements to be designed. This limitation was 

conservative. 

 71922 An incident was resolved for concrete frame design using the Canadian code CSA A23.3-04 in 

which the wrong phi factor for concrete was being used for the PMM interaction calculations. The 

value used was from the older version of the code CSA A23.3-94. Beam design was not affected, 

only column PMM design. 

Composite Beam Design 
Incidents Resolved 

* Incident Description 

 52236 An incident was resolved affecting the display of composite beam shear studs and their export to 

AutoCAD. The numbers of shear studs making up the beam shear-stud distribution were shown in 

the opposite order from the intended order for beams which met the following criteria: (1) The 

beam end points were defined from right to left, or top to bottom (2) the beam supported other 

beams or point loads (3) the beam loading was unsymmetrical, resulting in an unsymmetrical 

distribution of shear studs on the beam (4) the user did not select the Single Segment distribution 

in the Composite Design Overrides form. When this occurred, the total number of shear studs to be 

placed on the beam was not affected, only the ordering. 

 55288 

58914 

68731 

An incident was resolved for composite beam design that addressed two issues with the vibration 

check. (1) When the live-load reduction method was set to None in the model, the value of the 

dead load applied on the beam for the vibration check was too large, which resulted in the beam 

passing the vibration check by a large margin. When this occurred, the reported design results 

were obviously invalid for vibration. The results for strength stiffness criteria were still correct.  

(2) When a beam was supported by a column at one end and a girder at the other end, the total 

deflection of the system comprising the beam and its supports was very small, which resulted in 

the beam passing the vibration check by a large margin. When this occurred, the reported design 

results were obviously invalid for vibration. The results for strength and stiffness criteria were still 

correct. 
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* Incident Description 

 56192 An incident was resolved which affected the design of composite beams designed with no 

composite action. When computing the deflection of such beams, the moment of inertia of the 

steel section was being multiplied by the design preference value ‘Ieff Reduction Factor for 

Composite Deflections’, which is only intended to be used for composite action. Since this factor 

is usually less than unity (1.0), this could result in an over-conservative design when deflection 

controlled in the case of no composite action. 

 56782 An incident was resolved that addressed several issues affecting the design of steel composite 

beams per the BS 5950 British Standard Code of Practice. These issues only affected beams for 

which the governing design criterion was deflection. (1) The total deflection computed for design 

could be greater than the sum of the pre-composite and post-composite deflections. When this 

occurred, the resulting design was conservative. (2) The beam composite moment of inertia used 

to check composite deflections was being computed based on the effective ratio ‘ae’ used to check 

vibrations. (3) The reported value of the effective ratio ‘ae’ used to compute composite moment of 

inertia and deflections did not match the actual value used, nor did it match the theoretical value. 

This was because the reported ‘ae’ was computed based on a ratio of short-term to long-term loads 

that did not necessarily correspond to the loads in the load combination that controlled deflection. 

Example ‘BS-5950-90 Example 001’ in the Composite Beam Design Verification Manual has 

been updated according to these three changes.  

 61363 An incident was resolved for composite beam design where the reported number of shear studs 

required could be too small in the case where the percentage of composite action calculated to 

control beam deflection was less than the mandated minimum percentage. The number of shear 

studs was being calculated based on this smaller percentage of composite action rather than the 

mandated minimum. This did not affect the strength of the beam or any other design results. 

 63571 An incident was resolved for composite beam design where the price of steel per unit weight was 

not available for cost optimization. The price per shear stud and the cost per weight for cambering 

were available in the design preferences, and these functioned as relative prices compared to an 

assumed unit ($1.00) price for steel. Now the price per unit weight has been added to the design 

preferences and can be explicitly set along with the price for studs and cambering. In ETABS v9, 

the price of steel was available in the material property definition, but now the prices for 

composite beam design are all together in the design preferences. 

 63806 An incident was resolved for composite beam design where the default absolute deflection limits 

were set to zero when overwrites were assigned to a member and the option for ‘Deflection Check 

Type’ was selected as ‘Absolute’ or ‘Both’. The deflection limits could still be changed by the 

user. Now more reasonable default values are set. 

 68028 An incident was resolved for composite beam design where vibration checks reported the 

parameters B and W as zero when composite beams were framing into walls. 

 71297 An incident was resolved affecting the design of composite beams shored during construction. 

When shored construction was specified, a camber was specified for the beam based on the value 

of the beam deflection under dead load once construction was completed and shores were 

removed. When this happened, the beam had an upwards curvature which did not reduce when the 

concrete was poured (due to shoring), potentially leading to a thinner deck concrete cover than 

specified and resulting in an unconservative design. Composite beams for which shored 

construction has been specified are no longer cambered unless explicitly specified by the user. The 

Composite Beam Design Manuals applicable to the various design codes have been updated 

accordingly. Also, the default percentage of dead deflection which is cambered out is now 

properly given as 80% in these Manuals, reflecting the actual behavior of ETABS. 

 71303 An incident was resolved for composite beam design using the CSA S16-05 and CSA S16-09 

codes where the values computed by ETABS for the shear-stud capacity could be slightly 

incorrect. When this occurred, the computed shear-stud capacity differed from its prescribed value 

by 3% percent or less. Example "CSA-S16-09 Example 001" in the Composite Beam Design 

Verification Manual has been updated accordingly. 
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* Incident Description 

 71844 An incident was resolved which affected the design of composite beams per the AISC 360-05 and 

AISC 360-10 codes. The default values of the phi factors used to compute the composite design 

positive strength has been changed from 0.85 to 0.9 in accordance with the code specifications. 

The default value of 0.85 resulted in composite beam designs that were conservative, although the 

design was consistent with the value specified by the user if the default was not used. The phi 

factor used to compute the composite design negative strength has been removed from the 

preferences, as ETABS does not rely on composite action in areas of negative bending when 

designing composite beams; instead, the phi factor for bending of the steel section alone is used 

when evaluating strength in areas of negative bending. 

Shear Wall Design 
Incidents Resolved 

* Incident Description 

 68610 An incident was resolved for CSA A23.3-04 shear wall design where the phi factors for concrete 

and steel were not updated when overwritten by the user in the wall design preferences. Default 

values used in wall design preferences were in accordance with the CSA A23.3-04 code, therefore 

the actual design performed was per code. The wall design manual has been updated to reflect the 

default values used in wall design preferences. 

 68763 An incident was resolved for shear wall design using the Indian IS 456:2000 code where the design 

details displayed after right-button clicking on a spandrel showed incomplete information for 

diagonal reinforcement. In particular, certain seismic design information was omitted. The 

information that was being displayed was correct, and the design calculations were not affected. 

 70809 An incident was resolved for shear wall spandrel design using the NZS 3101-06 code where the 

Design Inadequacy Message: "Shear Force exceeds maximum allowed!" was shown incorrectly in 

the spandrel design output. The maximum design shear limits in accordance with NZS section 

9.3.9.3.3 were not being correctly enforced. The shear capacity and shear rebar calculations were 

not affected.  

Connection Design 
Incidents Resolved 

* Incident Description 

 55636 

65023 

An incident was resolved for steel connection design in which the D/C ratio was sometimes 

reported as excessively large or infinite when the model was created in any length unit other than 

inches. When this occurred the error was obvious. 

 57619 An incident was resolved for connection design where the ‘Set to Default Values’ button did not 

properly consider whether the connection was of beam or column type when setting the values. 

Results agreed with the values as set to default or subsequently changed by the user. 

 57795 Minor improvements have been made to the base-plate (connection) design. (1) A check has been 

added to ensure that the bearing length is greater than zero. (2) Checks have been added for the 

concrete bearing strength. (3) Minor improvements have been made to the base-plate thickness 

checks. (4) Minor improvements have been made to the side-face blowout checks 

Results Display and Output 
Incidents Resolved 

* Incident Description 

 61114 An incident was resolved where changing the units from US default to SI would incorrectly change 

the horizontal axis (spectral displacement) of the static pushover curve of type FEMA 440 EL 

(equivalent linearization). This was a graphical display issue only.  

 66574 An incident was resolved where walls drawn in plan or elevation were being included when printing 

to PDF files. 
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* Incident Description 

 66648 An incident was resolved for composite column design per the AISC 360-10 code that corrects two 

issues: (1) The composite column design calculation sheets in the report were blank. (2) The 

composite column design summary database tables were sometimes unable to be displayed. Both of 

these issues were reporting items only and did not affect the actual design results. 

 67079 An incident was resolved where the load case/combo name was not displayed in the caption when 

the reactions were plotted on screen in tabular form instead of arrows. 

 67084 An incident was resolved where the deformed-shape display, when shown in an elevation view, 

would sometimes snap-to and show displacement values at joints under the mouse cursor that were 

not in the displayed elevation plane. 

 67132 An incident was resolved where right-clicking on a frame assigned as pier or spandrel would not 

show the pier/spandrel design results when they were being displayed on the model. This did not 

affect shell elements. 

 67217 An incident was resolved for concrete frame design per the ACI 318-08 code where the Summary 

Report was reporting the longitudinal area of reinforcement required because of torsion in 

area/length units instead of area units. This was only a reporting issue. The design was not 

otherwise affected. 

 67368 An incident was resolved where, in rare cases, the caption for a model window that was displaying 

results for a load combination would show additional items (such as step numbers) that did not 

apply. No results were affected. 

 67377 

67857 

69952 

An incident was resolved where, in certain cases, trying to display hinge status or deformation for a 

pushover (nonlinear static) load case would cause the software to terminate abnormally. This was 

restricted to the 64-bit version. Results, when available, were not affected. 

 67470 An incident was resolved where non-fiber hinges with load carrying capacity after point E specified 

to be extrapolated (rather than dropping load) would report the hinge state as ‘D to <=E’ even for 

hinge deformations beyond point E. Now the hinge state will be reported as ‘> E’ in the 

extrapolated region. Also resolved was an error where the stiffness of the extrapolated region of the 

force-deformation curve was taken to be a very small but finite stiffness instead of using the 

stiffness of the curve between points D and E as documented. This latter issue only affected non-

isotropic, non-fiber hinges. 

 67650 An incident was resolved that addressed two issues affecting Link hysteresis plots: (1) The scaling 

of the vertical axes was not correct. (2) The link selection by name was not picking the correct link.  

Both issues were obvious and affected the plot only and not the tabulated analysis results. 

 68072 An incident was resolved where the beam moment diagrams would appear inverted in a developed 

elevation view when the developed elevation was first created. This did not affect subsequent 

displays of the same developed elevation. 

 68543 An incident was resolved where right-clicking on a joint when the joint reactions are being 

displayed would show zero values. 

 68858 An incident was resolved where the color legend would not show on the printed graphics when it 

was present for the screen graphics. 

 68931 An incident was resolved where displaying shell results (Display > Force/Stress Diagrams > Shell 

Stresses/Forces) and using the option to average the contours at the nodes ‘By Objects’ would leave 

the area objects (walls and floors) selected after display and until the Clear Selection command was 

used. No results were affected. 

 68935 An incident was resolved where, in certain cases, the load combination label as well as force/stress 

component type were not displayed in the window caption when displaying frame force results. 

 71305 An incident was resolved where displaying shell force or stress contours with the Show Values 

option on would sometimes show incorrect values for the contour labels. This could occur when the 

display units were not the same as the database units (the consistent units in effect when the model 

is created or imported from v9). In addition, the contour labels were not updated when the units 

form was used to change the units or accuracy of the display. This latter error depended on which 

window was active when the units were changed. In both cases, only the contour labels were 

affected, not the values shown under the mouse cursor or when right-clicking on the shell object. 
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* Incident Description 

 71761 An incident was resolved for steel frame design per the Eurocode 3-2005 code where the torsional 

force reported in the design report was using force conversion units instead of moment units. This 

was only a reporting issue and no other analysis or design results were affected. 

Detailing 
Incidents Resolved 

* Incident Description 

 56197 An incident was resolved in the detailer in which openings in waffle and ribbed slabs were not 

properly drawn on plan and section views. 

 57348 An incident was resolved in the detailer where specifying the same value for maximum and 

minimum bar spacing in a wall pier, in an attempt to enforce a specific bar spacing, was not having 

the desired effect. The resulting spacing could have been larger or smaller than requested when the 

range was zero. This has been corrected. Note, however, that such a restriction by the user may not 

always satisfy capacity requirements. 

 61360 An incident was resolved in which the beam rebar tables from detailing were not exported properly 

to DXF files. Trying to open the DXF file would generate an error message and the file was empty. 

 66800 An incident was resolved in which the minimum bar size specified in the rebar selection rules was 

not always enforced in the detailing of wall piers. This did not affect design. 

  68059 An incident was resolved in which changing units in the main Detailing Preferences form did not 

update the units properly for other subsidiary Detailing Preferences forms. 

 68539 An incident was resolved for the detailer in which some forms did not show the correct units for 

setting drawing sheet sizes when using SI/Metric units. Results were unaffected. 

 68559 An incident was resolved in which the export of detailing drawings and views to DWG did not work 

for some AutoCAD versions, causing ETABS to become non-responsive. Now when the export to 

DWG fails for any reason, an option is provided to try again or to export to DXF instead. Note that 

the export to DWG requires a recent version of AutoCAD to be installed on the same machine as 

ETABS so that the two products can communicate. Older versions of AutoCAD may work in some 

cases, but not all. 

Database Tables 
Incidents Resolved 

* Incident Description 

 62927 

65485 

An incident was resolved in which the composite beam design overwrites database table was 

sometimes unable to be generated for AISC 360-05, AISC 360-10, or Chinese 2010 codes. This was 

a table error only, which could also have affected the generation of reports, but did not affect 

results. 

 67574 An incident was resolved in which the Load Cases - Response Spectrum database table was using 

load names of UX, UY, etc instead of U1, U2, etc. This was a database table issue only and did not 

affect results. 

 67984 An incident was resolved in which the Shell Sections - Slab table was sometimes unable to be 

generated when there were ribbed slab properties present in the model. This was a table issue only 

and did not affect results. 

 68076 An incident was resolved in the database tables where a step number column was not present when 

presenting analysis results for certain load cases containing steps and when the table options were 

set to display the load case name and step number in separate columns. This was a database table 

issue only and did not affect results. 

 68484 An incident was resolved where saved table sets could become corrupted when the file was 

reopened. No results were affected. 

 68889 An incident was resolved in which the material list database tables would report the material for 

nonprismatic sections as steel when they were not. This was a table issue only and did not affect 

results. Nonprismatic sections are now included in the material list tables based on the material of 

the starting section. 
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* Incident Description 

 70061 An incident was resolved where the inter-story drift was not being reported in the drift tables for the 

bottom-most story of a tower if it was sitting on top of another tower. This was a reporting problem 

only and no other results were affected. 

 71616 An incident was resolved in the Shell Sections - Summary database table in which the Total 

Thickness column was reporting the thickness of a filled deck as the value of the concrete thickness 

only. This was a reporting issue only and did not affect any results. 

Data Files (.EDB, .E2K, .$ET) 
Incidents Resolved 

* Incident Description 

 60665 An incident was resolved where certain models could not be fully imported after being exported as 

text files (*.e2k, *.$et). The error occurred when reading group data. 

 63612 

68212 

An incident was resolved where, for certain rare models, composite beam design could not be 

performed due to corrupted data in the design settings. Exporting and re-importing the model would 

correct this issue. Now the data is corrected when it is opened from the model file (.EDB). 

 65361 An incident was resolved where line rebar specifications in Section Designer sections were not 

properly recovered when opening an ETABS v9 model into ETABS 2013 or when importing the 

model from a text file (*.e2k or *.$et). When this occurred, viewing the affected sections in Section 

Designer and clicking OK all the way back to the main interface would correct the problem. 

Without doing this, the design of such sections was affected, usually showing overstress due to lack 

of rebar. 

 65906 An incident was resolved where Section Designer section opening shapes were not exported or 

imported correctly in the text file. 

 68929 An incident was resolved in which ETABS v9 model files containing Section Designer sections 

could become corrupted when opened in v13.1.4 or v13.1.5. The Section Designer sections would 

be blank with zero properties. V9 models opened in v13.0.0 to v13.1.3 did not have this error. 

 69171 An incident was resolved where the CQC3 directional combination specification in Response 

Spectrum load cases was not being exported to the text file (*.e2k, *.$et) resulting in it being 

converted to the default SRSS directional combination upon import. 

 69322 An incident was resolved where, in rare cases, the message “Error cleaning Time History Plot 

Functions Array-Error 9” might appear when opening or saving a model. This error did not corrupt 

the model or affect any results. 

 69567 An incident was resolved where some hinges assigned to frame objects were not being written out 

to the model text file (*.e2k, *.$et), and hence were lost when the model was imported again. This 

did not affect models saved and opened using the model file (.EDB). This affected the export from 

versions 13.0.0 to 13.1.5. 

 69709 An incident was resolved where a model with a general pier design section could not be imported 

back after exporting to text file (*.e2k, *.$et). 

 71713 An incident was resolved where the shell section property was not imported correctly from v9 files 

if the bending thickness was specified to be different from the membrane thickness. The bending 

property modifiers are now modified when first importing the v9 file to reflect this difference in 

bending and membrane thicknesses. 

External Import/Export 
Incidents Resolved 

* Incident Description 

 65912 Two incidents affecting the export of models to AutoCAD DWG and DXF files were resolved: (1) 

When some of the grid lines in the model had blank labels, no DWG or DXF file was created. (2) 

Walls with three sides were exported as AutoCAD 3DFace objects with four points, one of which 

was at the drawing origin. When this occurred, the error was obvious. Both issues affected ETABS 

v9 and later. 
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* Incident Description 

 69982 An incident was resolved where exporting a story to SAFE was not including the reactions from 

braces tagged as sloping beams for the option Export Floor Loads and Loads from Above. 

 71499 An incident was resolved which affected the import of CIS/2 files. When the name of a CIS/2 file to 

import had several extensions, i.e., it contained more than one period, the file was not imported.  

Documentation 
Incidents Resolved 

* Incident Description 

 68264 An incident was resolved in which the help topic Local Axes - Shell Objects incorrectly 

documented the Normal to Selected Beam option as setting the local 2-axis of the shell to be 

perpendicular to the frame. This command sets the local 1-axis of the shell to be perpendicular to 

the selected frame. This was a documentation error only. 

 69246 A documentation error has been corrected in the Lateral Loads Manual, Section 2.12 for the 2009 

IBC/ASCE 7-05 seismic loads. The term Risk Targeted MCE in section 2.12.2, page 2-48, second 

paragraph was indicating that the Ss is the mapped Risk-Targeted MCER, when it is actually the 

maximum considered earthquake (MCE). ASCE 7-05 seismic maps are only for MCE. Separately, a 

clarification has been added in Section 2.1 and Section 2.2 of the Lateral Loads Manual for minor 

differences in the handling of lateral loads between various CSI products. No results were affected 

by these changes. 

 71127 The composite beam design verification examples manual and associated ETABS models have been 

updated. A few hand calculations were inaccurate and as a result did not exactly match the ETABS 

output. These calculations were corrected and now more closely match the original numbers output 

by ETABS. Other manual revisions are due to the ETABS output changing as a result of 

enhancements being made and incidents getting resolved; these changes appear in the Release Notes 

relative to these other enhancements and incidents. 

 71815 An incident was resolved in the context sensitive help where the description of the number of 

confinement bars data fields was incorrect in the Frame Section Property Reinforcement Data Form 

help topic. 

 


